
LAYERS and MASKS
The key to successful image editing

© Roy Killen 2021Roy Killen APSA, GMPSA/B, EFIAP, APSEM



2

This PDF document is a summary 
of a live presentation.  

Some of the slides require 
additional information to be fully 

understood. 

The text and images are copyright. Please 
do not distribute without my permission. 

roykillen@mac.com 



Topics to be covered

Non-destructive editing - why and how.

The concept of layers and how to use them in image editing.

When and how to use different types of layers.

The most useful layer blend modes.

Creating and using layer masks.

Layers in programs other than Photoshop.
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BEFORE YOU MAKE ANY 
CHANGES TO AN IMAGE

VISUALISE THE END RESULT 
YOU WANT

THEN PLAN HOW TO GET THERE IN 
LOGICAL STEPS 



Two approaches to image editing

• DESTRUCTIVE – Editing changes the pixels in 
the image and cannot be reversed. 

• NON-DESTRUCTIVE – Editing changes the 
appearance of the image without altering any 
of the pixels in the image, so the changes can 
be modified or reversed.
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Editing with layers (non-destructive editing) is a bit like 
adding make-up to a face. No matter how much make-
up you apply or what the face looks like with the make-
up applied, you can always wash it off and get back to 
the original face.

Direct editing of an image 
(destructive editing) is a bit like 
applying a tattoo to skin. Once it 
is there it is hard to change and 
you can never get back to the 
original skin.
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This is OK if EACH change you make produces 
exactly the result that you want and if you are 
certain you do not want to modify the changes 
at some later time.

In some basic photo-editing programs, all 
changes are made directly to pixels in the image.



NON-DESTRUCTIVE EDITING

• CAN BE DONE IN A RAW CONVERTER such as 
Adobe Camera Raw or Lightroom; or 

• CAN BE DONE IN AN IMAGE EDITOR THAT 
SUPPORTS THE USE OF LAYERS. 

     e.g.  Photoshop or Photoshop Elements 
   On1 (layers can be exported to PS) 

Luminar (layers can’t be exported to PS)
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Non-destructive editing in LIGHTROOM

When you edit an image in Lightroom it does not make any 
changes to the original image file.  

Information about the edits is saved as metadata in the 
Lightroom catalogue or as sidecar files (even after you’ve closed 
the image and quit the software). 

When you open the file at a later date the previous edits are 
automatically applied. 

You have the option to create a “virtual copy” of the file if you 
want to produce several different versions of the image. 
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Non-destructive editing in Adobe Camera Raw

When you edit an image in ACR it does not make any changes 
to the original image file.  

Information about the edits is saved  as metadata in a “sidecar 
file” (an .xmp file) that is automatically linked to the RAW file. 

When you open the file at a later date the previous edits are 
automatically applied. 

You have the option to save multiple versions of the file if you 
want to produce several different versions of the image. 
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Non-destructive editing with LAYERS

Layers are ‘containers’ that hold 
information about images or edits to 
allow changes to the appearance of an 
image without changing its original 
pixels.

All the information in the layers can be saved with the image.
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Different image editors use layers 
in slightly different ways - but the 
basic idea is the same.
The original file is not changed.  

Information about the edits is saved either automatically or 
when you save the file (depending on what software you are 
using).  

When you open the file at a later date (in the same software) 
the layers are still there (if you save the file correctly).
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Bottom layer

Top layer

Composite image

The layer concept
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Bottom layer

Adjustment layer “Black and White conversion layer” 

Composite  
(result of the adjustment)
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In this presentation I will explain how to use 
layers in Photoshop and those principles can 
easily be applied in other editors (such as 
ON1 or Luminar).



LAYERS in PHOTOSHOP
Layers are “holders of image or edit information”. 

The layers of information are stacked on top of one 
another to alter the appearance of the displayed image 
without changing the pixels in the original.

You can use layers to combine multiple images, make 
changes to the appearance of images, add text, etc.

Nothing worth doing in Photoshop 
should be done without layers. 
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ADVANTAGES OF USING LAYERS
• Edits/adjustments can be reversed or modified at any 

time (even after you save and re-open the file). 

• The intensity of any edit is easily adjusted by changing 
the opacity of the layer. 

• Adjustments can easily be applied to just part of an 
image and the area influenced by the adjustment can 
be modified at any time. 

• Several versions of edits can be tried and compared in 
one file. 

• Multiple images can be easily combined - e.g. 
composites, exposure blending, focus stacking. 
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When a file has multiple layers:
• The overall image is what you see “looking down 

through the layers”. 
• You can edit/change one layer without altering the 

other layers. 
• You can change the order of the layers. 
• You can change the position of objects on one 

layer without moving anything on the other layers. 
• You can rotate individual layers. 
• You can turn layers “on/off”.



The layers panel in PS

This is where you can create new layers, delete existing layers, 
move layers above and below one another, turn the visibility of 
layers on and off, change the transparency of layers, hide parts 
of a layer, change the way layers interact with one another . . . 

The “control centre” for layers in Photoshop



The layers panel

If the Layers Panel is not visible - from the menu select 
Windows>Layers (or press F7).



The layers panel

Name tab
Layers panel menu

Layers panel icons



When you open an 
image you create a 
BACKGROUND layer.

Layer name

Visibility indicator

Preview thumbnail

Lock
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You can make alterations and adjustments directly to this 
background layer - but it is not a good idea because this would 
be DESTRUCTIVE editing. 

At the very least you should DUPLICATE the background layer 
before doing any editing. 

Right click

Nothing changes here
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Layers that you place on top of the background layer may be: 

• Image layers  
• Fill layers (solid colours, gradients or patterns) 
• Adjustment layers (16 different types in PS CC) 
• Text layers 
• Transparent layers (empty - e.g. to use for cloning)

Types of Photoshop Layers
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When you place a layer above the “background layer”,  
what you see (and what will print) depends on: 

• The type of layer you add. 

• The “OPACITY” (transparency) of the new layer. 

• The way in which the new layer “interacts with” the 
layers below it. This is called the “BLEND MODE”. 

•  Whether or not you allow all (or only part) of the new 
layer to be visible. This is called “MASKING”.



The layers panel

Blend Mode 
of selected 
layer

Opacity of 
selected layer

Layer Mask

Adjustment layers

Filters



Layers panel menu

Grey items are not available for this 
layer either because it is locked or 
because the option is not relevant to a 
background layer.



Link two layers 

Layer effects 

Add layer mask 

Add fill or adjustment layer 

Group two or more layers 

Create a new empty layer 

Trash (delete the selected layer)

Layers panel icons



Creating NEW Layers
From the LAYERS MENU there are three options

Empty layer Fill Layer Adjustment layer



Create new FILL or ADJUSTMENT layer

Creating layers from within the Layers palette



FILL LAYERS
Fill the layer with: 

 A solid colour 

 A Gradient 

 A pattern 

Any colour

Any gradient available

Any pattern available



32

SOLID COLOUR FILL
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Simple use of a SOLID COLOUR FILL layer

+
Solid Colour Fill

Colour blend mode



Simple use of a GRADIENT FILL layer

+

Black to White Gradient Fill in “Soft Light” Mode



ADJUSTMENT LAYERS

Adjustment Layers contain no image data (no pixels) - just 
information about how Photoshop should alter the 
appearance of the image. 

It will affect all layers below the adjustment layer unless 
it is  are “clipped” to the layer immediately below.

The real magic of Photoshop



(a) The adjustment layers do NOT change any of the pixel 
information in your image. 

(b) You can REMOVE the layer simply by dragging it to the 
trash can in the layers panel. 

(c) You can CHANGE the adjustment by double clicking on 
the adjustment icon on the layer - the adjustment 
dialogue will re-open and you can make the change. 

(d) If you save the image as a PSD (Photoshop) or TIFF file 
the layers are preserved. Next time you open the 
image the layers are still there and you can make 
further adjustments to any layer if you want to.  

Adjustments that are made with ADJUSTMENT 
LAYERS are non-destructive because:



Creating new ADJUSTMENT layers
Option 1: Select from the Adjustments Panel.

If this panel is not visible, open it from the menu  Windows>Adjustments.



Select  
Layer>New Adjustment Layer 

from the Menu

Option 2:
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OPTION 3 - THE EASIEST - click on the new layer icon at the bottom of the Layers panel

Create new layer



TYPES OF ADJUSTMENT LAYER

Photoshop CC Photoshop Elements
Brightness/Contrast Brightness/Contrast
Levels Levels
Curves
Exposure
Vibrance
Hue/Saturation Hue/Saturation
Color balance
Black and White
Photo Filter Photo Filter
Channel Mixer
Color Lookup
Invert Invert
Posterize Posterize
Threshold Threshold
Selective Color
Gradient Map Gradient Map



Simple use of an ADJUSTMENT layer

Hue/Saturation 
Adjustment

+

Image with adjustment layerOriginal image



Simple use of an ADJUSTMENT layer
Original image

Colour LookUp 
Adjustment

+

Image with adjustment layer
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Simple use of an EMPTY layer
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• Add a new (empty) layer above the image. 
• Select that layer. 
• Use the clone stamp with the “All layers” 

option.





Add a new (empty) layer and use the cloning 
and/or healing tools to remove unwanted image 
elements.



Naming Layers

Renaming layers can help you to keep track of your editing.

• Select the layer (to make it the active layer). 

• Double click on the name and type in the new name, 

• OR select Layer>Rename Layer from the main menu.

To colour code a layer, right click on the layer and select the colour.
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CREATING A NEW LAYER FROM A SELECTION

• Make the selection using ANY selection method. 
• Press Cmd+J (Mac) or Ctrl+J (Windows) 
• (OR, From the menu select Layer>New>Layer via Copy.) 
• A new image layer based on the selection will be added above 

the currently selected layer.
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Opacity

LAYER OPACITY
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This changes the transparency of the 
layer if it is an image, or the amount of 
influence the layer has on the layers 
below if it is an adjustment layer. 

100% full effect 
  0% no effect

The OPACITY of any type of layer can be 
changed in Photoshop.



51Image as captured 

CHANGING LAYER OPACITY (TRANSPARENCY)
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Curves layer added to increase contrast

Opacity of Curves layer reduced 50%
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The layer BLEND MODE controls the way 
the active layer interacts with the layers 
below it.

“Normal” means the layer behaves as you would expect.

The effect of other blend modes depends on the 
colour information (hue, saturation, brightness) of 
the corresponding pixels in each layer and on the 
mathematical function that defines the blend mode. 
[You don’t need to understand the technical stuff in 
order to make good use of blend modes!]
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Blend mode can be 
changed by clicking 
on the double-headed 
arrow.



The BLEND MODES are in six groups:

DARKENING modes

LIGHTENING modes

CONTRAST modes

COLOUR modes

COMPARISON  modes

STANDARD modes



To cycle through the blend modes:

Select the Move tool (or any of the Selection tools).

Hold down the Shift key.

Press the + key.
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The most useful blend modes for photographers are: 

NORMAL
MULTIPLY
SCREEN
OVERLAY
LUMINOSITY
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One use for the MULTIPLY BLEND MODE

Blend the image with 
a copy of itself to add 
depth and richness to 
the colours.

[Black neutral]
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One use for the SCREEN BLEND MODE

Blend the image with 
a copy of itself to 
recover detail in dark 
areas.

[White neutral]
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[SOFT LIGHT is similar]One use for the OVERLAY BLEND MODE

Blend a Curves Layer 
(with no adjustments) 
to add contrast and 
richness to the colours.

[Grey neutral]
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One use for the LUMINOSITY BLEND MODE

Use Luminosity blend 
mode to remove 
colour shifts caused 
by some adjustments.



Original



Curves Adjustment - Normal blend mode



Curves Adjustment - Luminosity blend mode



COMBINING IMAGE LAYERS
Image layers are simply images stacked one on top of the other.

Bottom 
image

Composite image

+

Top image
Transparent



To place two images into layers 
in a single file

1. Open the first image (this makes it the 
background layer). 

2. Open a second image. 
3. Select all (or part of) the second image. 
4. Copy this selection. 
5. Switch to the first image. 
6. Paste the selection – it will become a new 

layer on top of the first image. 
7. Reposition the second image if necessary 

(using the Move tool).
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Blending two different images. 
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Images blended with “Darken” blend mode.



Blending an image and a fill layer

+



Blending an image and a fill layer



Dodge and Burn with Soft Light Blend 
Mode 

Open an image.
Add an empty layer.
Fill this layer with 50% grey. (Edit>Fill)
Change the blend mode to Soft Light.
Paint on grey layer - black to Burn, white to Dodge.

Use a soft brush at about 10% opacity.

You can get a stronger effect with Overlay or Hard Light blend modes.









Four important things about blend 
modes.

• Blend modes are non-destructive. You can change the 
blend mode on a layer as often as you like without 
altering any of  the pixels in the layer.  

• When you save a layered file (in PSD or TIFF format) 
the blend modes of  all layers are saved.  

• Changing the blend mode of  one or more layers does 
not change the file size when the file is saved.  

• The effects of  some blend modes change when you 
change the Opacity of  the blend layer.



LAYER MASKS
Used for hiding part of a layer.

On a LAYER MASK you can have shades of grey (no colours): 

• WHITE – this part of the mask is transparent. It has no effect. 
It does not hide anything. 

• BLACK – this part of the mask is fully opaque. It totally hides 
the effect of that part of the layer. 

• Shades of GREY – this part of the mask is partially 
transparent. It partially reduces the effect of that part of the 
layer (depending on the shade of grey).



Background layer - no layer mask



Layer mask with BLACK added



Layer mask with BLACK and 50% GREY added
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If you want an adjustment to be applied to 
just PART of an image . . .  

• Create an adjustment layer and make 
the adjustment (to the whole image). 

• Create a LAYER MASK and use black to 
cover the areas of the image that you 
do NOT want to be adjusted. 
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When you create an ADJUSTMENT layer, a white layer mask is 
automatically added to the layer.  
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When you create a FILL layer, a BLACK layer mask is 
automatically added to the layer. 

You can paint on a mask with BLACK or WHITE or Grey.

If you want to add a mask to any layer you can do it “manually”:

A mask can be created from any SELECTION.
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After you create a layer mask you can:

•Invert it (change black to white and white to black). 

•Paint on it to modify the black/white area. 

•Blur the mask. 

•Alter it with any adjustments available for greyscale images. 

•Reduce the opacity of the mask without changing the opacity the layer. 

•Move or copy the mask to another layer.
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Creating a Layer Mask from a Selection

• Make the selection using ANY selection method. 
• Click on the mask icon at the bottom of the layers palette. 
• A mask based on the selection will be added to the active layer.
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A typical application of layer masks.
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Layer Masks can be used to combine two images.



Top layer

Bottom layer Final image

Mask on top layer
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To DUPLICATE any image or adjustment layer:

Select the layer. 
Press Cmd+J (Mac) or Ctl+J (Windows)

To move a layer: 

Select the layer. 
Click and drag to the new position.

To delete a layer: 
Select the layer. 
Click and drag it to the bin, OR 
Press ‘backspace’ or ‘delete’.

Some Layer Shortcuts
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Creating a ‘Stamped’ Layer

Cmd+Option+Shift+E (Mac) 
Ctrl+Alt+Shift+E (Windows)

This process merges (combines) all the active layers 
and creates a new layer above the selected layer.

}
Original layers remain.
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Why is a stamped layer useful?

It is a handy way of producing several different versions of an image 
(different edits) without destroying any of the adjustment layers.

Some filters cannot be applied unless the layers are flattened.

It allows you to ‘flatten” (merge) the layers without discarding any of 
the adjustment layers.  You can come back later and change the 
adjustments. 
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Clipped layers

Hold Option/Alt and click the line between two layers to “clip” the top 
layer to the layer underneath it.

When a layer is “clipped” to the layer below, adjustments on 
the clipped layer will affect only the layer immediately below 
(not the whole image).

Change

No Change
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Layer groups

Select the layers to be grouped. 
Cmd/Ctrl+G to place all the selected layers into a layer group.

Helps you keep the layers palette organised if you have a lot of layers.

This allows you to work with a group of layers without merging them.
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Locking Layers

Some features of a layer can be locked so that they cannot be (accidentally) changed.

Lock transparent pixels

Lock image pixels

Lock layer position

Prevent auto-nesting into Artboards

Lock all
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Linking Layers

If you need to move something in your image that’s made from several layers, 
you can link the layers before you use the Move tool so that the layers can be 
moved as a single unit.
Linking related layers can help you avoid accidentally misaligning layers. For 
example, if you have done cloning on a separate layer it is useful to link that 
layer to its source layer to ensure the cloning stays perfectly aligned.

Click here to link selected layers.
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All layers are saved when you save the 
file as a PSD or TIFF file (provided you 

do not “flatten” the layers before saving).  

It is not possible to save layers in a 
JPEG file. 



Create  a new document with layers preserved

If you have a document with multiple layers and you 
want to quickly create a new document with all those 
layers (perhaps to experiment with some different 
ideas):

Select “Create new document from current state”.

Open the “History” palette.



Create a new document from a single layer



RIGHT click on the layer name and select “Duplicate Layer”

Select “New”

Name the new document

Highlight the layer.



If multiple layers are selected, the new document 
will contain all those selected layers.
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LAYERS IN LIGHTROOM?

Layers are not available in Lightroom, but . . .

2. Images can be combined using the Print module in Lightroom: 
  https://www.youtube.com/watch?v=OMgY2C89yVA 

1.  You can use Adjustment Brushes - roughly equivalent to  PS Adjustment 
Layer with a Mask 

3. From the Library module, images can be edited in an external program that does 
use Layers - for example, Photoshop, ON1, Luminar - and then brought back to 
Lightroom. The layers from Photoshop and ON1 are retained but layers from 
Luminar are not.

https://www.youtube.com/watch?v=OMgY2C89yVA


LAYERS IN ON1 Photo RAW

Same basic principle as layers in Photoshop for Adjustment 
Layers and Image Layers.

Opacity of each layer can be adjusted.

Blend Mode of each layer can be adjusted - most of the 
modes that are available in Photoshop.

Layer Masks can be painted on each layer.

Adjusted file can be saved as a .PSD file that retains the 
layers.



LAYERS IN LUMINAR 4

Same basic principle as layers in Photoshop for Adjustment 
Layers and Image Layers.

Opacity of each layer can be adjusted.

Blend Mode of each layer can be adjusted, but only 13 
modes are available.

Layer Masks can be painted on each layer.

When adjusted file is exported, the layers are flattened.
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The End
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www.roykillen.photography

roykillen@mac.com

http://www.roykillen.photography
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